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i VHDL

| i brary | EEE;
use | EEE. std logic 1164. all; A C
entity HALF ADDER is B ) S
port ( A B : in std_|ogic;
S, CO: out std |logic); :>}*’CO

end HALF_ADDER,

archi tecture DATAFLOW of HALF _ADDER is
signal C, D: std_|ogic;
begi n
C <= A or B
D <= A nand B;
CO <= not D
S <= C and D

end DATAFLOW
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i VHDL

library 1EEE;
use IEEE.std _logic_1164.all;

STD_LOGIC

entity HALF_ADDER is

port ( A, B : IN std_logic;
S, CO : OUT std_logic );

end HALF_ADDER;

architecture DATA_FLOW of HALF ADDER is

signal C, D : std_logic;

begin
C<=AorB;
D<=AnandB ;
CO <= notD;
S<=CandD;

end DATAFLOW;
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std logic

N
‘0 T ‘X
'U" | Uninitialized ‘W' | Weak Unknown
‘X" | Unknown 'L'" | Weal Low
'0" | Low 'H'" | Weak High
'1' | High Don't care
'Z' | Hi-impedance
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1. login
2. nirai  rlogin

% rlogin nirai

.cshrc

source /usr/synopsys/setup 2000.05/init/synopsys_setup_2000.05

a. nirai  rlogin
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%0 xhost nirai
%0 xhost nirai-1

2 nirai

hosthame PWO01
% setenv DISPLAY hosthname:0.0

3 nirai vhdl

% mkdir vhdl
% cd vhdl
% cp /home/teacher/wada/pub/*.*
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hadder test.vhd

library IEEE; begin
use IEEE.std_logic_1164.all; UO: HALF_ADDER port map (IN1, IN2, S, CO);

process begin
IN1<='0"; IN2<='0";
wait for 10 ns;
IN1<='0"; IN2<="'1";
wait for 10 ns;

entity HADDER_TEST is
end HADDER_TEST;

architecture TESTBENCH of HADDER_TEST is INI<="1": IN2<="0' :
component HALF_ADDER wait for 10 ns:
port (A, B :in std_logic; IN1<='1": IN2<='1":
S, CO : out std_logic); wait for 10 ns;
end component; wait;
signal IN1, IN2, S, CO : std_logic end process;

end TESTBENCH,;

HADDER_TEST
configuration CFG_ADDER of HADDER_TEST is

for TESTBENCH
end for;
end CFG_ADDER;

PROCESS

2001/1/18-19 10



m VHDL

1. VHDL
half _adder.vhd
hadder_test.vhd

2. (VHDL
% vhdlan half_adder.vhd
% vhdlan hadder_test.vhd

o VHDL Debugger
1. VHDL Debugger
% vhdldox CFG_ADDER &
VHDL Debugger

VHDL Debugger

2001/1/18-19

trace * signal

run 50
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CO
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2

o design_analyzer

% design_analyzer &

File->Read...
half _adder.vhd

HALF_ADDER

Tool-=>DesignOptimization

2001/1/18-19
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= ALU

Sel[4:0]
> N Sel[1:0] * Self?] Sel[4:3]
AlZ:0] Logic (LogicUnit]7:0
: Unit
¥[7:0
B[7:0] 70}

§ Arith
Unit
>

mMux Shifter -

]

Carryin
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AithUnitg]  ALU-NoShif7:0]



o ooooooof
oooooocooll

(el elelie]
[eMelelie]
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S2

0 Y <=A A Arithmetic Unit
0 Y <= A+l A Arithmetic Unit
0 Y<=A+B Arithmetic Unit
0 Y<=A+B+1 Arithmetic Unit
0 Y <= A + Bbar A Arithmetic Unit
0 Y <=A +Bbar +1 Arithmetic Unit
0 Y<=A-1 Arithmetic Unit
0 Y <=A A Arithmetic Unit
1 Y<=AandB Logic Unit

1 Y<=AorB Logic Unit

1 Y <= A xor B Logic Unit

1 Y <= Abar Logic Unit

0 0 0 0  Y<=A A Shifter Unit

0 0 0 0 Y<=shA A Shifter Unit

0 0 0 0 Y<=grA A Shifter Unit

0 0 0 0 Y<=0 Shifter Unit

15



alu.vhd

library IEEE;
use IEEE.STD_LOGIC_1164.all, IEEE.NUMERIC_STD.all;

entity ALU is
port(Sel : in unsigned(4 downto 0);
: in std_logic
downto 0);
downto 0) );
begin

ALU_AND_SHIFT:

process (Sel, A, B, Carryln)
variable Sel0_1_Carryln : unsigned(2 0);
\ariable LogicUnit ArithUnit,

ALU_NosShift  : unsigned(7 downto 0);

begin

LOGIC_UNIT: case Sel(1 downto 0) is

when "00" => := A and B;
LogicUnit := A or B;
when "10" => LogicUnit xor B;

LogicUnit := not A;
when others ==> LogicUnit := (others => 'X");
end case LOGIC_UNIT;

2001/1/18-19

SelO_1_CarryIN := Sel(1 downto 0) & CarryIN;
ARITH_UNIT: case Sel0_1_Carryln is
when "000" => ArithUnit
ArithUnit := A+1;
when "010" => ArithUnit := A+B;
when "011" => = A+B+1;
ArithUnit := A + not B;
when "101" == ArithUnit := A-B;

when "110" => = A-

when "111" => ArithUnit := A;

when others => := (others == 'X");
Mutiplex

LA_MUX: if (Sel
ALU_NosShift := LogicUnit;
else
ALU_NoSHift :=

-- Shift operation

Sel(4 3)is
when "00" => Y <= ALU_NoSHift;
when "01" => Y <= (ALU_NoShift

when "10" => Y <= Shift_right ALU_NoShift, 1);

when others => Y <= (others => 'X");
end case SHIFT;
end process ALU_AND_SHIFT;
end architecture COND_DATA_FLOW;

16



3 AU

design_analyzer

% &
2 File->Read
alu vhd
3. ALU
4 1
|
1. Tool-=>DesignOptimization

2001/1/18-19
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test alu.vhd

library IEEE;

use IEEE.STD_LOGIC_1164.all, IEEE.NUMERIC_STD.all;

entity TEST_ALU is
end TEST_ALU;

architecture TESTBENCH of TEST_ALU is
component ALU
port ( Sel :in unsigned(4 downto 0);
Carryln :in std_logic;
A,B :in unsigned(7 downto 0);

Y : out unsigned(7 downto 0));
end component;
signal SIN : unsigned(4 downto 0);
signal CIN : std_logic;

signal AIN,BIN,YIN : unsigned(7 downto 0);
begin
UO: ALU port map (SIN,CIN,AIN,BIN,YIN);
process begin

AIN <= "00001111"; BIN <="11110000",

wait for 10 ns;
SIN <= "00000"; CIN <= "0";
wait for 10 ns;
SIN <= "00000"; CIN <="1%;
wait for 10 ns;
SIN <= "00001"; CIN <= "0%;
wait for 10 ns;
SIN <= "00001"; CIN <= "1%;
wait for 10 ns;
SIN <= "00010"; CIN <= "0%;
wait for 10 ns;

2001/1/18-19

SIN <= "00010"; CIN <="1%;
wait for 10 ns;

SIN <= "00011"; CIN <="'0%
wait for 10 ns;

SIN <="00011"; CIN <="1%
wait for 10 ns;

SIN <= "00100"; CIN <= "'0%;
wait for 10 ns;

SIN <="00101"; CIN <="'0%;
wait for 10 ns;

SIN <="00110"; CIN <="0%;
wait for 10 ns;

SIN <="00111"; CIN <="'0%
wait for 10 ns;

SIN <= "01000"; CIN <= "0%;
wait for 10 ns;

SIN <= "10000"; CIN <= "0%;
wait for 10 ns;

SIN <= "11000"; CIN <= "'0%;
wait for 10 ns;

wait;

end process;
end TESTBENCH;

configuration CFG_ALU of TEST_ALU is
for TESTBENCH
end for;

end CFG_ALU;

18



4 ALU

VHDL

VHDL
alu.vhd : ALU
test_alu.vhd : ALU

(VHDL
% vhdlan alu.vhd
% vhdlan test_alu.vhd

VHDL Debugger
VHDL Debugger

% vhdldbx CFG_ALU &
VHDL Debugger

RUN

2001/1/18-19

trace * signal

19
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= RAID
s Encoder / Decoder
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= Redundant Array of Inexpensive Disks

c HDD

C1/C2/C3

D1

RAID

D2

D1/D2/D3

HDD

Encoder/Decoder

D3 —§

2001/1/18-19

Encoder

k4

!

REEELE

L J

Decoder

—D1

——=2

—=D3
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ﬁ Encoder / Decoder

o D 2D3/C3

1 1" 2" 3 1 1 1[4

c2 =1 2t 3 |d2 (=1 2 3|42] - D
3] 1P 2° 3|43 [1 4 5]d3

(A1 [1 o of&l]

g2 =12 3 1|el| - (&

43| |3 2 1]e2)

19



2001/1/18-19



2001/1/18-19

TV

TV

MP &
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Gk2)
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GF(2%)

O]l 0| N|] o] o ] W] N]| B

[EnY
o

I
[N

[EnY
N

[EnY
w

QIQIQIQRQRalalalalalalalala

=Y
N
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= 3x3 GF(24)

s 3X3==>qag4Xa4=qa?
m (]8

m 3xXx3=5
= 0011 X 0011 => 0101

2001/1/18-19

==
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VHDL
1. gflog / gfilog

2.

2001/1/18-19

GF(2%)
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/ gfilog

10 >a a° >al?2 =5
1000X1010 => 0011+1001 == 1100 ==1111

]
a =1
X9 >aX o >abb g4 > 4=>3
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gflog

4 4
0000 XXXX (DON T CARE)
0001 0000
0010 0001
0011 0100
0100 0010
0101 1000
0110 0101
0111 1010
1000 0011
1001 1110
1010 1001
1011 0111
1100 0110
1101 1101
1110 1011
1111 1100

31



gflog.vhd

ibaryl EE;

use EEESD_IOGLC_164al,IEE. NMRICSD. d;
-- 2N 4G doiFeldL g onerson

--assamng gfbg Q) %5;

dovnbo 0;
y :out msgne(3dovnb §);
end ety GFIOG;

2001/1/18-19

achited¢ue OMBofGEO G s
begin
[po s §x)

endc ae;
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i ( gflog.vhd

gflog.vhd
test gflog.vhd

= design_analyzer

20 @/1/18-19

VH D Debugger
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|

4 4
0000 0001
0001 0010
0010 0100
0011 1000
0100 0011
0101 0110
0110 1100
0111 1011
1000 0101
1001 1010
1010 0111
1011 1110
1100 1111
1101 1101
1110 1001
1111 XXXX (DON'T CARE)

2001/1/18-19

gfilog
gfilog

gfilog.vhd
test gfilog.vhd

34
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gfmult.vhd

library I1EEE; begin

use IEEE.STD_LOGIC_1164.all, IEEE.NUMERIC_STD.all;

-- 274 Galoi Fileld Multiplier U0: GFLOG port map (ina, Iogina);
- Tom Wada U1: GFLOG port map (inb, loginb);

entity GFMULT is . .
sum <= ('0' & logina) + (‘0" & loginb);

port (ina :in unsigned(3 downto 0);
inb :in unsigned(3 downto 0);
product : out unsigned(3 downto 0)); MOD_CAL: process(sum) begin
end entity GFMULT; if (sum >= 15) then
mod15 <= sum - 15;
architecture RTL of GFMULT is else
component GFLOG mod15 <= sum:;
port ( x :in unsigned(3 downto 0); end if:
y : out unsigned(3 downto 0)); ’

end component; end process MOD_CAL;

component GFILOG

port ( x 2 in unsigned(3 downto 0); U2: GFILOG port map (mod15(3 downto 0), ilogmod);
y : out unsigned(3 downto 0));
end component; MUX: process(ina, inb, ilogmod) begin
if (ina =0 or inb = 0) then
signal logina,loginb : unsigned(3 downto 0); product <= "0000";
signal sum : unsigned(4 downto 0); else
signal mod15 : unsigned(4 downto 0); . .
signal ilogmod : unsigned(3 downto 0); endpri(;-dUCt <= llogmod;

end process MUX;

end architecture RTL;

2001/1/18-19 36



gm it ()

g imult.vhd, gflog.vhd, gfilog.vhd

3
READ SHIFT
GMUD - GLOG 2
GMULT Edit>Uniquify>Hierarchy
GFMULT - GFMULT
Attributes>Coptimization
Directives>Cell dgroup Cell s Hierarchy
GFMULT

Report Area
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a;, Of+a, o+ a
AND
4

o 4=qa

o+ a,

XOR

38



+

| 4 #ae,az,al,ao B:b3,b2,b1,bo

(a8’ +a,a° +a, 8" +a,) +(bya° +b,0a” +ba’ +hy)
=(a,Ab)a’+(a,Ab)a’+(a,Ab)a’ +(a,Aby)

11+7 =1011A 0111=1100=12
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A

a‘=a+l a°=a’+a a‘=a’+a°’
(a,ca°+a,xa’+aa’ +a,)Xb,a’+b,2a’+ba’ +h,)
=(a,,)a’ +(a, b, Aa,h,)a’+(a, ", Aa,,Aa x)a*
+(a,%h,Aa, ", Aa, b, Aa,,)a’+(a,,Aa b Aa,b,)a’
+(a, ", A a,°b,)a +a, o,
=(a, ", Aa, > Aa o, Aa b, Aa,b)a’
+(a, %, Aa b Aa,b,Aa, b, Aa, b, Aa,b)a’
+(a, ", Aa, b, Aa, ", Aa, b, Aa, b Aa, b, Aa b)a
+a,>b, Aa, b, Aa, b, Aa b,
= AND 16 XOR
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i gfmult2

o gfmult2

= gfmult2.vhd(entity GFMULT2)

2001/1/18-19
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gfmult2.vhd

library IEEE; architecture RTL of GFMULT2 is
use |IEEE.STD_LOGIC_1164.all, IEEE.NUMERIC_STD.all; begin
-- 274 Galoi Fileld Multiplier easy version product(3)<= (ina(3) and inb(0)) xor
- Tom Wada (ina(2) and inb(1)) xor
(ina(1) and inb(2)) xor
entity GFMULT2 is (ina(0) and inb(3)) xor
) . . (ina(3) and inb(3));
port ( ina :in unsigned(3 downto 0); product(2)<= (ina(2) and inb(0)) xor
inb :in unsigned(3 downto 0); (ina(1) and inb(1)) xor
product : out unsigned(3 downto 0)); (ina(0) and inb(2)) xor
end entity GFMULTZ2; (ina(3) and inb(3)) xor

(ina(3) and inb(2)) xor
(ina(2) and inb(3));
product(1)<= (ina(1) and inb(0)) xor
(ina(0) and inb(1)) xor
(ina(3) and inb(2)) xor
(ina(2) and inb(3)) xor
(ina(3) and inb(1)) xor
(ina(2) and inb(2)) xor
(ina(1) and inb(3));
product(0)<= (ina(0) and inb(0)) xor
(ina(3) and inb(1)) xor
(ina(2) and inb(2)) xor
(ina(1) and inb(3));
end architecture RTL;

2001/1/18-19
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B Entity
B Clock

2001/1/18-19

REG9

WE IO’
Dout
REGQ@@]‘VEﬁﬂ;

Clock _|—|_|—|_|—|_
add O X X
Dout Y%
Din ¢ % '

C{J')_TI‘J*Z)‘I? .:{D_T—_yi)"ﬁ CfDI_UiJ"‘E

EFiLds EFAH S
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REGY

library IEEE;
use IEEE.STD_LOGIC_1164.all, IEEE.NUMERIC_STD.all;

entity REG9 is
port (ADD :in unsigned(3 downto 0);
DIN :in unsigned(3 downto 0);
WE :in std_logic;
CLK :in std_logic;
DOUT : out unsigned(3 downto 0));
end entity REG9;

architecture RTL of REG9 is
---- 4bit x 9 register type ----
type RegType is array (0 to 8) of unsigned(3 downto 0);
---- 4bit x 9 register declaration ----
signal elereg : RegType;
begin
process (CLK)
begin
if (rising_edge(CLK)) then
if (WE = '1") then elereg ( TO_INTEGER(ADD) ) <= DIN;
else
DOUT <= elereg( TO_INTEGER(ADD) );
end if;
end if;
end process ;

end architecture RTL;

2001/1/18-19
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o VHDL Debugger

reg9.vhd
test_reg9.vhd

= design_analyzer

Attributes -> Clock -> Specify
Period Apply

2001/1/18-19
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(5 Encoder/Decoder

7 Encoder/Decoder
Decoder:
|
Encoder/Decoder

D1 ® D1

D2 P Decoder —D2

D3: —§ » —=D3
Encoder

2001/1/18-19

Encoder

2" 3Pl 11 1]d1
23t |4z |=(1 2 3|42 - (D
2 F 43| (1 4 5|43

o o1
3 10cl] - @
2 1|c2
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§ ENCODER DECODER

(ADD) (ELE)
(CLK) (WE)
s CLK GET=1 IN1/IN2/IN3
OUT1/0UT2/0UT3
—*GET DOHE—™
—H1 OUTI—™
— 2 OuUT2—™
— M GF- oura—™
— o loppMATMULT
—»ELE OUT1| [ELE[Add = 0] ELE[Add =1] ELE[Add =2]| iv1
— »WE OUT2 |=| BLE[ Add = 3] ELE[Add =4) FELE[ Add = 5]] IE'JE]
e FESET OUT3 | | ELE[Add = 6] ELE[Add =7] ELE[Add =8]| IN3

T
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RS-RAID

* DOHE

#L0uT

*D20UT

EWE ENCODER WE DWE DECODER WE ADD/ELE
EWE/DWE ENCODER/DECODER
D1IN/D2IN/D3IN C1/C2/C3/DONE
D10OUT/D20UT/D30UT
DI el hit 4y Il
LI bl 4y D2 gpen
i ENCODER e DECODER
HET g GET DOHE L:}ET DONE
M1 0Tl 1 OUT1
QT2 %M 01T
GF-  ours[epm 3K GF- ouTz
anpMATMULT p o MATMULT
—WELE ——WELE
R »WE
oLk RESET eLE RESET
ATD gl F 3 F 3
ELE —p
EWE —pm
L'WE —p
CLE ®
RESET
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*DI0UT
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s Encoder / Decoder

SETUF SEQUENCE

H—]
aR

FLAER

i
aR

FLAER

52
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OPERATING SEQUENCE

CLE

A [

D1IN, D2

DECEI]DER
g
SR Ly

- 2ILEB R
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gfmatmut.vhd

test rsraid.vhd
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IS AHLTHETHBE

CLK | | |
GET [ | | ' |

IN1,2,3 — !

| OET=100CLET+/TING2 3% A4

L R AT D
E HRDCLK T o3/ TOUT1,2, 3 DONE#M 5,
OUT1,2,3 - — '
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] DONE
IH1
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TH2 o
IH3 oiT
W 555 S35 568
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REGH
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gfmatmult.vhd

library IEEE;
use |IEEE.STD_LOGIC_1164.all,
IEEE.NUMERIC_STD.all;

entity GFMATMULT is

port (GET :in std_logic;
IN1 :in unsigned(3 downto 0);
IN2 :in unsigned(3 downto 0);
IN3 :in unsigned(3 downto 0);
ADD :in unsigned(3 downto 0);
ELE :in unsigned(3 downto 0);
WE :in std_logic;
CLK :in std_logic;
RESET :in std_logic;
DONE : out std_logic;
OUT1 : out unsigned(3 downto 0);
OUT2 : out unsigned(3 downto 0);
OUT3 : out unsigned(3 downto 0) );

end entity GFMATMULT;

architecture RTL of GFMATMULT is

---- GFMULT2 ----
component GFMULT2
port (ina  :in unsigned(3 downto 0);

inb  :in unsigned(3 downto 0);

product : out unsigned(3 downto 0) );

end component;
---- 4bit x 9 register type ----

type RegType is array (0 to 8) of unsigned(3
downto 0);

---- ELE register file ----
signal elereg : Regtype;

2001/1/18-19

---- input registers ----
signal din1, din2, din3 : unsigned(3 downto 0);
---- output registers ----
signal doutl, dout2, dout3 : unsigned(3 downto 0);
---- done registers ----
signal getd1, getd2 : std_logic;
---- partial products ----
signal pd0,pd1,pd2,pd3,pd4,pd5,pd6,pd7,pd8 : unsigned(3 downto 0);

begin

---- REG9 write logic ----
REG9_WT: process (CLK)
begin
if (rising_edge(CLK)) then
if (WE="1") then elereg(TO_INTEGER(ADD)) <= ELE;
end if;
end if;
end process REG9_WT;

---- input register logic ----
INPUT_REG: process (CLK)

begin
if (rising_edge(CLK)) then
if (GET="1") then

dinl <= IN1;
din2 <= IN2;
din3 <= IN3;

end if;

end if;

end process INPUT_REG;

---- gfmult2 array ---
U0: GFMULT2 port map (elereg(0),din1, pd0);
U1l: GFMULT2 port map (elereg(1),din2, pdl);
U2: GFMULT2 port map (elereg(2),din3, pd2);
U3: GFMULT2 port map (elereg(3),din1, pd3);
U4: GFMULT2 port map (elereg(4),din2, pd4);
U5: GFMULT2 port map (elereg(5),din3, pd5);
U6: GFMULT2 port map (elereg(6),din1, pd6);
U7: GFMULT2 port map (elereg(7),din2, pd7);
U8: GFMULT2 port map (elereg(8),din3, pd8);

---- output register logic ----
OUTPUT_REG: process (CLK)
begin
if (rising_edge(CLK)) then
doutl <= pd0 xor pd1 xor pd2;
dout2 <= pd3 xor pd4 xor pd5;
dout3 <= pd6 xor pd7 xor pd8;
end if;
end process OUTPUT_REG;

---- done logic ----
DONE_LOGIC: process(CLK)
begin

if (rising_edge(CLK)) then

getdl <= GET;

getd2 <= getdl;
end if;

end process DONE_LOGIC;

--- output assigns ---
DONE <= getd2;
OUT1 <= doutl;
OUT2 <= dout2;
OUT3 <= dout3;

end architecture RTL;
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GFMULT2 9
GFMULT2 3 1
GFMATMULT
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